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Отзывы слушателей курса

Издательский дом «Весь»
Очень	интересный,	а	главное	—	полезный	курс.	Были	сомнения	в	его	необхо-
димости,	но	после	третьего	занятия	стало	ясно,	что	он	полезен	на	100%!	Спа-
сибо	 огромное,	 что	 есть	 такое	 место,	 где	 можно	 получить	 все	 необходимые	
в	наше	время	знания	о	компьютерных	технологиях.
Получены	знания,	необходимые	для	активной	работы	с	данной	программой.	
Программа	освещена	в	объеме,	соответствующем	выделенному	времени.	Осо-
бенно	 хотелось	 бы	 отметить,	 что	 данный	 курс	 посвящен	 последней	 версии	
программы!
Отличный	 курс,	 грамотная	 схема	 занятий	 и	 полезный	 материал.	 Отличные	
пособия.	Преподаватель	отлично	умеет	объяснять	и	находить	решение	про-
блем.	Все	занятия	были	проведены	грамотно	и	интересно.

Федорова Н. И.
Все	очень	гармонично	скомпоновано	и	продумано.	Полагаю,	что	пригодится	
в	работе,	т.	к.	раньше	(со	скрипом)	это	же	приходилось	делать	в	Adobe	Illustra-
tor.

Владимирский М. Ю.
Курс	Adobe	InDesign	построен	емко,	логично	и	дает	довольно	полное	пред-
ставление	о	данной	программе	верстки	(насколько	вообще	можно	ее	уложить	
в	столь	короткий	объем	учебного	времени).	

Богуславская П. Э.
Курс	насыщенный	и	очень	полезный.	Включает	в	себя	все	необходимые	во-
просы.	Хорошо	то,	что	он	максимально	приближен	к	практике.	Очень	понра-
вился	высочайший	профессионализм	и	интересная	подача	материла.	Огром-
ное	спасибо	за	освещение	практических	вопросов,	именно	то,	что	необходимо	
было	узнать,	придя	на	курс.

Веткина Л. И.
Данный	курс	содержит	все,	что	нужно	для	работы!	Удивительно,	я	смогла	па-
раллельно	с	изучением	курса	на	работе	сделать	настоящий	буклет!	Спасибо	за	
то,	что	можно	почерпнуть	такое	количество	полезной	информации	в	одном	
месте!





Посвящается моей замечательной
маме — Агаповой Римме,

чудесным образом воспитавшей во мне
несгибаемую волю к победе.

Введение
На	кого	рассчитана	эта	книга?	Книга	рассчитана	на	широкий	круг	читателей,	
уровень	знаний	которых	может	колебаться	от	базового	до	среднего.	Книга	со-
держит	 массу	 полезных	 советов	 и	уроков,	 изучение	 и	выполнение	 которых	
позволит	 последовательно	 совершенствовать	 технику	 работы	 в	программе.	
Читатели	с	базовым	уровнем	знаний	постепенно	научатся	работать	в	програм-
ме,	изучая	урок	за	уроком.	Читатели,	имеющие	навыки	работы	в	других	гра-
фических	 программах,	 также	 не	 будут	 скучать,	 поскольку	 рабочая	 среда	
и	принципы	работы	Adobe	InDesign	отличаются	от	принятых	в	Adobe	Illustra-
tor,	Adobe	PageMaker	или	QurkXpreess,	с	которыми	принято	сравнивать	дан-
ную	программу.
Смогу	ли	я	с	помощью	данной	книги	разобраться	в	компьютерной	графике?	Чест-
но	говоря,	данная	книга	содержит	главу,	в	которой	излагаются	общие	сведе-
ния	о	компьютерной	графике,	такие	как	отличие	растровой	и	векторной	гра-
фики,	обзор	популярных	форматов	файлов	и	т.	д.	Но	основной	целью	книги	
является	изучение	возможностей	программы,	а	общие	сведения	о	компьютер-
ной	 графике	 приводятся	 лишь	 потому,	 что	 без	 некоторых	 базовых	 понятий	
невозможно	дальнейшее	движение	вперед.	
Я	уже	давно	работаю	в	сфере	компьютерной	верстки,	будет	ли	мне	полезна	книга	
подобного	уровня?	Книга	является	помощником	в	самостоятельном	освоении	
приемов	работы	в	программе	Adobe	InDesign.	Независимо	от	того,	работали	
вы	раньше	с	другими	программами	или	нет,	вам	может	потребоваться	помощь	
в	объяснении	того,	как	устроена	та	или	иная	команда,	поиске	какой-либо	па-
литры	или	инструмента.	Тем	более,	что	Adobe	InDesign	имеет	массу	маленьких	
хитростей,	не	зная	о	которых,	можно	работать	не	самым	рациональным	обра-
зом.	
Могу	ли	я	рассчитывать	на	то,	что	изучение	этой	книги	поможет	мне	повысить	
профессиональный	уровень?	Самостоятельное	изучение	любого	материала,	ко-
нечно,	желательно	рано	или	поздно	подкрепить	посещением	курсов	или	се-
минаров.	Но	существует	масса	примеров,	когда	люди,	начиная	с	нуля	изучать	
определенные	программы,	добивались	впечатляющих	результатов.	В	данной	
книге	собраны	только	те	материалы,	которые	нужны	в	работе.	Это	—	необхо-
димый	минимум,	четко	усвоив	который,	вы	сможете	почувствовать	себя	уве-
ренно,	открыв	программу.
Можно	ли	изучать	эту	книгу	непоследовательно?	Практические	задания,	прила-
гающиеся	к	каждой	следующей	главе	книги,	основываются	на	материале,	изу-
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ченном	ранее.	Но,	тем	не	менее,	понимая,	что	первое	время	очень	сложно	за-
помнить	 даже	 название	 элементов	 интерфейса,	 не	 то	 что	 их	 назначение	
и	принцип	работы,	я	составляла	подробные	пошаговые	инструкции	как	вы-
полнять	 задание.	 Однако	 предполагается,	 что	 вы	 должны	 чуть-чуть	 «вырас-
тать»	 после	 изучения	 каждой	 следующей	 главы	 и	к	концу	 книги	 задания	
усложняются,	а	инструкции	слегка	упрощаются.
Рассматриваются	ли	в	данной	книге	сложные	вопросы,	связанные	с	цветоделе-
нием,	треппингом	и	т.	д.?	В	данной	книге,	в	силу	того,	что	она	является	само-
учителем,	по	возможности	данные	темы	обходятся	стороной,	чтобы	не	пугать	
неискушенных	пользователей	непонятной	терминологией.	Однако	без	пони-
мания	некоторых	терминов	работа	в	программе	просто	немыслима,	поэтому	
я	 включила	 необходимый	 для	 полноценной	 работы	 минимум	 объяснений,	
проливающий	 свет	 на	 такие	 понятия,	 как	 Overprint	 и	Knockout,	 PostScript	
и	EPS,	обтравочный	контур	и	спуск	полос,	а	также	некоторые	другие.
У	 меня	 версия	 программы	 Adobe	 InDesign	 CS,	 подойдет	 ли	 она	 для	 изучения	
данной	книги?	К	сожалению,	сохранение	из	Adobe	InDesign	CS2	в	формате	
более	ранней	версии	невозможно,	а	использование	формата	INX	для	обме-
на	 данными	 между	 версиями	 InDesign	 оказалось	 осложнено	 необходимо-
стью	 устанавливать	 дополнительные	 обновления	 с	сайта	 производителя.	
Именно	поэтому	некоторые	учебные	файлы		на	диске	не	удалось	сохранить	
в	таком	формате,	который	можно	было	бы	открывать	и	пользователям	бо-
лее	 ранних	 версий,	 и	пользователям	 версии	 CS2.	 Теоретическая	 же	 часть,	
изложенная	в	книге,	позволит	вам	изучать	и	версию	CS	и	CS2,	однако,	ис-
пользуя	старую	версию,	вы	не	сможете	воспользоваться	некоторыми	новы-
ми	возможностями.
Я	не	плохо	знаю	Adobe	Illustrator,	стоит	ли	мне	отдельно	изучать	InDesign?	По-
жалуй,	 стоит,	 поскольку	 эти	 программы	 сильно	 различаются	 между	 собой.	
И	в	первую	 очередь	 они	 различаются	 не	 только	 программными	 средствами,	
а	идеологией,	поскольку	Illustrator	—	это	программа,	предназначенная	для	ри-
сования,	 а	InDesign	—	 программа,	 предназначенная	 для	 работы	 с	большими	
объемами	текстового	и	графического	материала.	К	тому	же	InDesign	содержит	
массу	профессиональных	средств	контроля	над	процессом	подготовки	макета	
к	печати,	таких	как	возможность	просматривать	будущие	пленки,	устанавли-
вать	сразу	для	всего	документа	припуск	на	обрезку	и	т.	д.
Я	слышал,	что	профессиональная	работа	в	значительной	степени	основана	на	ис-
пользовании	 горячих	 клавиш,	 приучаете	 ли	 вы	 к	этому?	 Обязательно!	 В	книге	
горячие	клавиши	прописаны	для	всех	операций,	для	которых	их	действитель-
но	целесообразно	использовать.	Более	того,	в	книге	есть	отдельный	лист	со	
списком	необходимых	для	работы	клавиатурных	сокращений.	Использование	
данного	принципа	в	работе	позволит	сэкономить	массу	времени	при	решении	
трудоемких	задач.
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Рассматриваются	 ли	 в	данной	 книге	 какие-то	 интересные	 приемы	 работы	 или	
речь	идет	просто	о	последовательном	объяснении,	что	и	как	работает?	К	книге	
на	диске	прилагаются	уроки,	для	выполнения	которых	потребуется	использо-
вание	различных	нестандартных	приемов	работы.	К	тому	же	без	такого	мате-
риала	книга	была	бы	скучной,	поэтому	в	нее	включены	различные	алгоритмы	
как	 средствами	 программы	 (градиенты,	 обтекания	 текстом,	 маскирование,	
трансформация)	создавать	необычные	красивые	эффекты.	





Глава 1

Осваиваемся в рабочей 
области InDesign

Настройки нового документа
Итак,	как	и	в	любой	другой	графической	программе,	в	InDesign	работа	начи-
нается	с	создания	и	настройки	нового	документа.	Давайте	же	рассмотрим	те	
важные	 и	 полезные	 настройки	 документа,	 которые	 необходимо	 выполнить,	
начиная	работу.
Первое,	что	вам	для	этого	понадобится,	—	это,	конечно	же,	команда	главного	
меню	File>New.	Вы,	наверно,	удивитесь,	увидев	несколько	вариантов	того,	что	
можно	создать	при	помощи	данной	команды.	Вариант,	интересующий	вас,	—	
Document.	К	остальным	мы	еще	вернемся,	но	позже.
Итак,	мы	приступаем	к	настройке	окна	New	Document	(рис.	1.1).

Рис. 1.1. Диалоговое окно команды New Document

Окно	команды	New	Document:
1.	 Выпадающий	список	возможных	размеров.
2.	 Количество	страниц.
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3.	 Создавать	развороты.
4.	 Расположение	страницы.
5.	 Группы	настроек	документа.
6.	 Количество	колонок.
7.	 Величины	полей.

А	теперь	об	этом	же,	но	подробнее.
1.	 Выпадающий	 список	 размеров	 —	 содержит	 готовые	 варианты	 печатных	

размеров.	В	полях	Width	и	Hight	вы	видите	численные	значения.	Если	вы	
работаете	над	публикацией	с	нестандартным	размером,	вы	должны	просто	
ввести	нужные	вам	размеры	в	поля	Width	и	Hight,	ничего	не	выбирая	из	
выпадающего	списка	размеров.

2.	 Количество	страниц	—	поле	для	указания	желаемого	количества	страниц	
в	документе.	Не	обязательно	стразу	указывать	точное	количество	страниц	
документа,	их	всегда	можно	будет	добавить	или	убавить	в	процессе	рабо-
ты.

3.	 Создавать	 развороты	 —	 разрешение	 компоновать	 в	 документе	 страницы	
попарно	(как	в	книгах).	Отключенный	флажок	создает	документ	со	стра-
ницами,	показываемыми	по	одной	на	экране.	

4.	 Расположение	страницы	—	ориентация	документа:	портретная	или	альбом-
ная.

5.	 Группы	настроек	документа	—	набор	всех	настроек	данного	окна.	Выпол-
нив	единожды	какие-либо	настройки	документа,	их	можно	сохранить	под	
неким	именем	(в	примере	—	my)	и	обращаться	ко	всем	разом,	просто	вы-
бирая	 имя	 набора	 настроек	 из	 списка.	 Можете	 поэкспериментировать,	
для	этого	нажмите	кнопку	Save	Preset	после	выполнения	всех	настроек.

6.	 Количество	колонок	—	число	колонок	на	страницах	публикации.	Особен-
ность	данного	параметра	заключается	в	том,	что	указанное	число	колонок	
будет	у	всех	до	единой	страниц,	что	не	всегда	бывает	нужно.	Если	вам	как	
раз	не	нужно,	то	проще	будет	в	данном	поле	оставить	единицу,	а	потом	уже	
вручную	указывать	для	отдельных	страниц,	на	сколько	колонок	их	нужно	
разбить.

7.	 Величины	полей	—	размеры	всех	полей	публикации.	Причем	если	вы	раз-
решили	использовать	развороты	(см.	п.	3),	то	при	настройке	будут	фигури-
ровать	названия	Outside	и	Inside	—	внутреннее	и	внешнее	поля,	а	если	раз-
воротов	в	документе	нет,	то	Left	и	Right	—	левое	и	правое.

Думаете,	что	все	настройки	выполнены	и	можно,	наконец,	попасть	в	рабочую	
область	InDesign?	А	вот	и	нет.	Есть	еще	как	минимум	одна	полезная	настрой-
ка.	Это	—	припуск	на	обрезку,	или	Bleed.	Итак,	нажимаем	кнопку	More	Op-
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tions	(под	OK	и	Cancel).	И	без	того	большое	окно	New	Document	удлиняется,	и	
мы	видим	поля	для	ввода	величины	Bleed.
Но	прежде,	чем	вводить	туда	числа,	давайте	обсудим,	зачем	их	туда	нужно	вво-
дить?	Дело	в	том,	что	при	подготовке	файла	вы	должны	учесть,	что	при	обрез-
ке	документа	устройство	может	сделать	это	с	некоторой	погрешностью,	бук-
вально	на	несколько	миллиметров,	но	тогда,	например,	ваш	лист	А4	уже	будет	
не	А4	а	чуть	меньше.	Еще	один	вариант	развития	событий,	когда	в	результате	
обрезки	 картинка,	 стоящая	 у	 края,	 становится	 не	 самой	 крайней	 точкой.	
К	публикации	прибавляются	лишние	миллиметры	чистой	бумаги,	в	результа-
те	чего	появляется,	например,	белая	полоса.
Чтобы	этого	избежать	используется	припуск	на	обрезку.	Вы	сознательно	уве-
личиваете	вашу	публикацию	на	несколько	миллиметров	со	всех	сторон	(обыч-
но	на	2–5	мм),	и	при	обрезке	отрезают	то	лишнее,	что	вы	заложили	в	размер.
Область	Bleed	в	InDesign	показана	оранжевой	границей.	Если	вы	ее	указали	
при	 создании	 документа	 —	 используйте	 ее!	 Не	 забывайте	 о	 ней.	 Теперь	 все	
объекты	необходимо	выравнивать	по	оранжевому	краю,	а	не	по	краю	публи-
кации.

	Все,	что	расположено	за	областью	Bleed,	на	печать	выводиться	не	будет.	Реально	
увидеть,	как	будет	выглядеть	документ	после	печати	и	обрезки	(т.	е.	без	припуска	
на	обрезку),	можно,	нажав	клавишу	<W>.

Итак,	 документ	 настроен	 и	 вы	 уже	 в	 рабочей	 области	 InDesign.	 Где	 теперь	
можно	 выполнить	 те	 важные,	 основополагающие	 настройки,	 которые	 при-
сутствовали	в	окне	New	Document?	Дело	в	том,	что	в	InDesign	после	создания	
документа	рассмотренные	настройки	разбиваются	на	две	группы.	Одни	теперь	
находятся	 в	 диалоговом	 окне	 Document	 Setup	 главного	 меню	 File,	 а	 другие	
в	Columns&Margins	 главного	 меню	 Layout.	 Давайте	 рассмотрим,	 какие	 на-
стройки	куда	попали?
В	окне	File>Document	Setup	остались	все	настройки,	кроме	тех,	что	отвечают	за	
количество	колонок	и	размер	полей.	Даже	кнопка	More	Options,	благодаря	ко-
торой	можно	указать	размер	припуска	на	обрезку,	осталась	в	этом	окне	(кста-
ти,	если	вы	забыли	указать	этот	важный	параметр	при	создании	документа,	
никогда	не	поздно	будет	это	сделать	в	процессе	работы).
Количество	 колонок	 и	 размер	 полей	 настраиваются	 отдельно.	 Из	 главного	
меню	Layout>Margins&Columns	вы	получаете	доступ	к	значениям	этих	пара-
метров.	Однако	обращаю	ваше	внимание,	что	те	значения,	которые	вы	вводи-
те	в	этом	окне,	применяются	только к той странице, на которой вы стоите.	
Это	значит,	что	для	десятистраничного	документа	придется	десять	раз	вызы-
вать	окно	с	настройками.	Чтобы	не	делать	этого	так	часто,	нужно	менять	ко-
личество	колонок	и	размер	полей,	стоя	на	мастер-шаблоне	(о	них	мы	погово-
рим	в	гл. 3).



1�� Глава�1

Рабочая область InDesign
Когда	документ	настроен,	можно	приступать	к	рассмотрению	особенностей	
рабочей	области	(рис.	1.2).

Рис. 1.2. Снимок рабочей области InDesign

Элементы	рабочей	области	InDesign:
1.	 Область	вставки	(Pasteboard).
2.	 Управляющая	палитра	(Control	palette).
3.	 Страница	публикации.
4.	 Палитры.
5.	 Панель	инструментов.
6.	 Выпадающий	список	с	номерами	страниц.

1.	 Область	вставки	используется	для	размещения	на	ней	материалов,	которые	
нужны	в	работе,	но	окончательное	их	место	в	публикации	еще	не	определе-
но.	Если	вам	не	хватает	места,	то	можно	увеличить	размер	Pasteboard	в	вы-
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соту.	Для	этого	в	главном	меню	Edit>Preferences>Guides&Pasteboard	нужно	
увеличить	параметр	Minimum	Vertical	Offset.

2.	 Управляющая	палитра	является	важным	элементом	рабочей	области.	Она	
позволяет,	не	прибегая	к	командам	главного	меню,	инструментам	и	дру-
гим	палитрам,	выполнять	различные	манипуляции	с	текстом,	объектами	и	
таблицами.	Не	убирайте	ее	с	экрана.	Эта	палитра	нужна	всегда.	Если	вы	
все-таки	 нечаянно	 ее	 потеряете	 из	 виду,	 найти	 управляющую	 палитру	
можно	в	главном	меню	Window>Control	Palette.

3.	 Страница	публикации	—	это	то	пространство,	куда	вы	должны	размещать	
все,	что	намереваетесь	напечатать.	Именно	эта	область	выводится	на	пе-
чать	(плюс	припуск	на	обрез,	если	указан).

4.	 Палитры	—	 основные	 элементы	 рабочей	 области.	 Их	 в	 InDesign	 очень	
много,	но	все	одновременно	они	не	показываются.	Если	вам	нужна	кон-
кретная	палитра,	которую	вы	не	видите,	ищите	ее	в	главном	меню	Window.	
В	InDesign	палитры	пристыковываются	вертикально,	поэтому	изначально	
вы	 видите	 только	 вкладки	 с	 названиями	 палитр.	 Если	 хотите	 поработать	
с	палитрой	—	кликните	по	вкладке	с	именем,	палитра	полностью	раскроет-
ся	для	работы.	Повторный	щелчок	по	вкладке	с	именем	вернет	ее	назад.

	Хорошая	привычка	временно	убирать	с	экрана	все	ненужное	в	данный	момент	
палитры.	 Так	 просторнее.	 Для	 этого	 нажмите	 <Shift>+<Tab>	—	это	 скрытие	
всего,	кроме	самых	важных	элементов	—	панели	инструментов	и	управляющей	
палитры.	 Нажатие	 просто	 клавиши	 <Tab>	 уберет	 с	 экрана	 все	 палитры.	 По-
вторное	нажатие	клавиш	вернет	все	назад.	Еще	профессиональнее	будет	вызы-
вать	во	время	работы	только	нужную	палитру	горячей	клавишей.	В	процессе	зна-
комства	с	работой	InDesign	мы	изучим	основные	сочетания	клавиш	для	вызова	
различных	палитр.

5.	 Панель	 инструментов.	 Без	 нее	 работа	 немыслима.	 Недаром	 при	 нажатии	
<Shift>+<Tab>	эта	панель	остается	на	экране.	Из	этой	панели	вызываются	
все	 рабочие	 инструменты	 и	 активизируются	 атрибуты	 объекта	 (заливка,	
обводка).	Если	вы	все-таки	спрятали	ее,	то	для	вызова	панели	нужно	будет	
из	главного	меню	Windows	выбрать	Tools.

6.	 Выпадающий	список	с	номерами	страниц	используется	как	средство	навига-
ции	 по	 документу.	 Выбрав	 пункт	 из	 списка,	 вы	 переходите	 на	 страницу	
c	этим	номером.	В	списке	вы	найдете	такую	запись,	как	«A-master».	Это	—	
мастер-шаблон	 вашей	 публикации.	 Не	 используйте	 его,	 если	 не	 знаете,	
как	он	работает.	Это	приведет	к	появлению	на	всех	страницах	элементов,	
присутствующих	на	мастер-шаблоне.

	Для	быстрого	перемещения	по	страницам	публикации	можно	использовать	го-
рячие	клавиши	<Ctrl>+<J>.	После	этого	введите	номер	страницы,	на	которую	
хотите	перейти,	и	нажмите	<Enter>.
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Работа с палитрами
Прежде	чем	приступать	к	работе	в	среде	InDesign,	давайте	разберемся	с	неко-
торыми	 терминами,	 необходимыми	 для	 работы	 с	 палитрами.	 Раскройте	 па-
литру	Swatches	(рис.	1.3)	<F5>.	На	ее	примере	разберемся	с	терминологией.

Рис. 1.3. Палитра Swatches

Важные	элементы	палитры:
1.	 Контекстное	меню	палитры.

2.	 Корзина.

3.	 Пиктограмма	создания	нового	объекта.

1.	 Контекстное	меню	палитры	содержит	массу	полезных	команд,	относящих-
ся,	непосредственно	к	данной	палитре.

2.	 Корзина	служит	для	удаления	ненужных	образцов	из	палитры.	Выделите,	
например,	 зеленый	 цвет	 в	 своей	 палитре	 и	 утащите	 его	 на	 пиктограмму	
корзины.	Если	все	сделано	правильно,	зеленый	должен	пропасть	из	набо-
ра	цветов.

3.	 Пиктограмма	 создания	 нового	 объекта	 используется	 для	 создания	 нового	
образца	в	палитре.	В	зависимости	от	того,	какую	палитру	вы	используете,	
вы	 можете	 получить	 новый	 слой,	 новый	 цвет,	 новый	 стиль	 параграфа	
и	т.	п.	При	щелчке	в	палитре	Swatches	по	рассматриваемой	пиктограмме	
образуется	новый	образец	цвета	на	основе	того,	который	в	данный	момент	
активен.

Итак,	три	рассмотренных	элемента	палитры	будут	встречаться	нам	на	протя-
жении	всей	работы	в	InDesign	у	всех	палитр.	Поэтому	следует	запомнить,	где	
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и	что	находится,	чтобы	каждый	раз	не	перечитывать	первую	главу,	встречая	
в	тексте	ссылку	на	«контекстное	меню	палитры».

Работа с панелью инструментов
Как	уже	отмечалось	выше,	панель	инструментов	является	очень	важной	со-
ставляющей.	 Давайте	 познакомимся	 с	 некоторыми	 ее	 элементами	 ближе.	
Во-первых,	давайте	нарисуем	в	рабочей	области	объект,	на	котором	можно	
было	 бы	 ставить	 эксперименты.	 Для	 этого	 воспользуйтесь	 инструментом	
Rectangle	Tool	(рис.	1.4).	Нарисуйте	прямоугольник.

Рис. 1.4. Панель инструментов при активном инструменте  
для создания геометрических примитивов

Теперь,	на	примере	нарисованного	объекта,	обсудим	назначение	двух	различ-
ных	инструментов	выделения.

	 Инструмент	 Selection.	 Служит	 для	 выделения	 объектов,	 а	 при	 нажатой	
клавише	 <Ctrl>	 для	 изменения	 размеров	 объекта.	 Попробуйте	 кликнуть	 по	
нарисованному	объекту	инструментом.	Появление	голубого	габаритного	кон-
тейнера	означает	выделение	объекта.

	 Инструмент	Direct	Selection.	Служит	для	выделения	опорных	точек	объек-
та.	 Выделите	 объект	 черной	 стрелкой,	 а	 затем	 возьмите	 белую	 стрелку.	 Вы	
должны	увидеть	опорные	точки	вашего	объекта.	Сейчас	можно	выделить	лю-
бую	из	них.	Выделите	поочередно	нижние	точки	и	сдвиньте	внутрь,	получите,	
таким	образом,	трапецию.

	 Инструмент	Rectangle.	Служит	для	рисования	одноименных	геометриче-
ских	примитивов.

	 Инструмент	Ellipse.	Служит	для	рисования	всевозможных	кругов	и	ова-
лов.

	 Инструмент	Polygon.	Служит	для	рисования	многоугольников	и	звездо-
чек.	Щелкните	дважды	по	пиктограмме	многоугольника	в	панели	инструмен-
тов,	 и	 вы	 увидите	 поле	 для	 ввода	 значений	 величины	 лучей	 для	 рисования	
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звездочек	(измеряется	в	процентах	от	внешнего	радиуса)	и	количества	сторон	
объекта.	Кстати,	количество	сторон	удобно	менять	в	процессе	рисования	объ-
екта,	нажимая	на	клавиатуре	стрелки	вверх	и	вниз.
Прямоугольник	и	эллипс	можно	настроить	перед	созданием,	если	кликнуть	
курсором	в	виде	выбранного	инструмента	по	рабочему	полю	(рис.	1.5).

Рис. 1.5. Диалоговое окно инструмента Rectangle Tool

Как	 вы	 заметили,	 инструментов	 для	 создания	 геометрических	 примитивов	
в	InDesign	меньше,	чем,	например,	в	Adobe	Illustrator.	Например,	отсутствует	
инструмент	«прямоугольник	со	скругленными	углами».	Но	подобные	объекты	
можно	легко	получить	другим	способом.	Да	и	разнообразие	форм	углов	будет	
больше.	Итак,	представляю	вам	команду	главного	меню	Object>Corner	Effects	
(рис.	1.6).	Она	знаменательна	тем,	что	из	выпадающего	списка	Effect	можно	
выбрать	различные	варианты	оформления	углов	фигуры,	а	в	пункте	Size	ука-
зывается	величина	эффекта.	Флажок	Preview	держите	включенным,	иначе	все	
настройки	будете	выполнять	вслепую,	не	видя,	что	происходит	с	объектом,	до	
тех	пор,	пока	не	нажмете	кнопку	OK.

Рис. 1.6. Окно команды Corner Effects

	 Инструмент	 Line.	 Предназначен	 исключительно	 для	 создания	 прямых	
линий.	При	рисовании	инструментом	с	нажатой	клавишей	<Shift>	создаются	
горизонтальные,	вертикальные	или	наклоненные	под	углом	45°	линии.

	 Инструмент	Pencil.	Предназначен	для	рисования	любых	объектов.	Ими-
тирует	рисование	карандашом	от	руки.

T	 Инструмент	Type.	Используется	для	создания	текстовых	фреймов	и	ввода	
текста.	Давайте	запомним	одно	правило:	в	InDesign	текст	существует	исключи-
тельно	внутри	текстовых	фреймов.	Сам	по	себе	—	без	фрейма	—	он	существо-
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вать	не	может.	Поэтому	ввод	текста	с	клавиатуры	нужно	начинать	с	создания	
фрейма.	Фрейм	создается	рисованием	прямоугольника	инструментом	Type.
Итак,	 нарисуйте	 пустой	 текстовый	 фрейм	 (если	 не	 делать	 никаких	 лишних	
действий,	 то	 после	 рисования	 текстовый	 курсор	 будет	 мигать	 внутри	 фрей-
ма	—	это	то,	что	нам	нужно).	Теперь	щелкните	правой	кнопкой	мыши	и	выбе-
рите	команду	Fill	with	Placeholder	Text	(рис.	1.7).

Рис. 1.7. Окно команды Fill with Placeholder Text

Данная	команда	очень	удобна	для	образовательных	целей,	поскольку	она	по-
зволяет	быстро	создать	блок	с	текстом,	на	котором	можно	экспериментиро-
вать	с	различными	командами	и	инструментами.	Еще	одно	практическое	на-
значение	 этой	 команды	—	это	 подготовка	 макетов	 для	 заказчиков.	 Если	 вы	
уже	заготовили	каркас	будущего	буклета	или	газеты,	но	реальных	текстовых	
материалов	у	вас	пока	нет,	можно	использовать	данную	команду	для	заполне-
ния	любых	площадей	текстом.
Работая	с	текстовыми	фреймами,	лучше	держать	включенным	показ	границ	
объектов.	По	умолчанию	этот	режим	включен.	Благодаря	ему	вы	видите	все	
объекты	в	тонкой	голубой	рамке.	Почему	целесообразно	работать	с	этим	ре-
жимом?	Потому	что	в	нем	вы	видите	даже	пустые	текстовые	фреймы,	которые	
вы	нарисовали,	но	текстом	не	заполнили.	Их	присутствие	на	странице	крайне	
нежелательно,	а	режим	показа	границ	объектов	поможет	их	найти.	Если	все-
таки	вас	раздражает	голубая	рамка	всех	объектов,	ее	можно	отключить,	нажав	
<Ctrl>+<H>.
Итак,	мы	рассмотрели	небольшой	набор	инструментов,	которых	нам	должно	
хватить	на	первое	время.	В	панели	инструментов	осталось	еще	много	нерас-
смотренных	образцов,	но	к	ним	мы	вернемся	в	следующих	главах.	А	пока	да-
вайте	начнем	применять	то,	что	уже	изучили.
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Строение объектов
У	каждого	объекта	в	InDesign	есть	два	обязательных	атрибута	—	это	обводка	
(Stroke)	 и	 заливка	 (Fill).	 Обводка	 —	 это	 внешняя	 граница	 объекта,	 а	 залив-
ка	—	это	его	тело,	наполнение.	Поскольку	эти	атрибуты	есть	у	любого	объекта,	
вы	не	должны	забывать	их	настраивать,	чтобы	не	создавать	себе	проблем.
Когда	вы	рисуете	объект,	в	панели	инструментов	вам	показываются	текущие	
установки	обводки	и	заливки.	По	умолчанию	обводка	у	объекта	черная,	а	за-
ливка	отсутствует.

Рис. 1.8. Так выглядят атрибуты объекта в панели инструментов

Для	того	чтобы	изменить	цвет	атрибута,	щелкните	по	нужной	вам	пиктограм-
ме	 (по	 обводке	 или	 по	 заливке)	 и	 выберите	 цвет	 (например,	 из	 палитры	
Swatches).	Не забывайте,	что	назначение	цвета	выполняется	для	того	атрибу-
та,	который	сейчас	на	переднем	плане!	Например,	если	судить	по	рис.	1.8,	то	
сейчас	вся	работа	ведется	с	обводкой,	а	заливка	у	объекта	и	вовсе	отсутствует.
В	 особенном	 положении	 находятся	 текстовые	 фреймы.	 С	 одной	 стороны,	
текст,	который	находится	внутри	фрейма,	имеет	собственные	обводку	и	за-
ливку.	С	другой	стороны	—	фрейм,	внутри	которого	расположен	текст,	тоже	
имеет	обводку	и	заливку.	Именно	поэтому	вы	можете	в	процессе	работы	пере-
ключаться	между	обводкой	и	заливкой	фрейма	и	обводкой	и	заливкой	текста	
внутри	фрейма.	Для	этого	предназначены	кнопки	под	пиктограммами,	обо-
значающими	Fill	и	Stroke	 (см.	рис.	1.8.).	Щелкая	по	кнопке	в	виде	квадрата,	
вы	видите	атрибуты	фрейма,	а,	выбирая	кнопку	в	виде	буквы	Т,	вы	работаете	
с	атрибутами	самого	текста.

Копирование объектов
Во	время	работы	зачастую	необходимо	создавать	идентичные	копии	объектов,	
будь	 то	 текстовые	 фреймы	 или	 рисунки.	 Для	 этого	 существуют	 различные	
способы.	Самый	простой,	которым	лично	я	пользуюсь	чаще	остальных,	—	это	
копирование	с	клавишей	<Alt>.
1.	 Выделяем	объект	инструментом	Выделение	(черная	стрелка).
2.	 Нажав	клавишу	<Alt>,	начинаем	сдвигать	объект	в	тот	момент,	когда	кур-

сор	превращается	в	раздвоенную	стрелку.
3.	 Если	при	этом	действии	нажимать	еще	и	<Shift>,	то	копии	объектов	будут	

двигаться	по	прямой.
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	Если	у	объекта,	который	вы	копируете	с	<Alt>,	нет	заливки,	то	это	означает,	что	
у	объекта	нет	«тела»,	он	пустой	внутри.	Его	можно	скопировать	описанным	спо-
собом,	только	подведя	курсор	к	обводке	или	центральной	точке	объекта.

Второй	способ	—	это,	конечно	же,	копирование	через	буфер	обмена.	Данный	
способ	 безопасен	 для	 копирования	 объектов	 внутри	 среды	 InDesign.	 Дело	
в	том,	что	перенос	данных	через	буфер	обмена	считается	процессом	небезо-
пасным.	Но	на	копирование	объектов	внутри	среды	InDesign	это	правило	не	
распространяется.	Итак:
1.	 Выделяем	объект	черной	стрелкой.
2.	 Нажимаем	горячие	клавиши	<Ctrl>+<C>.
3.	 Встаем	на	ту	страницу,	на	которой	необходимо	выгрузить	содержимое	бу-

фера	обмена.
4.	 Нажимаем	горячие	клавиши	<Ctrl>+<V>.
Кстати,	 есть	 замечательный	 способ	 выгрузить	 содержимое	 буфера	 обмена	
в	то	 же	 место,	 откуда	 данные	 были	 скопированы.	 Для	 этого	 используется	
команда	 главного	 меню	 Edit>Paste	 in	 Place	 (Вставить	 на	 то	 же	 место)	 или	
<Ctrl>+<Alt>+<Shift>+<V>.

Третий	способ	используется	для	создания	массива	объектов.	Из	исходного	
объекта	получается	сколько	угодно	копий,	которые	вставляются	с	заданным	
шагом	смещения.	Речь	идет	о	команде	главного	меню	Edit>Step	and	Repeat.
1.	 Копируем	объект	(<Ctrl>+<C>).
2.	 Вызываем	команду	Step	and	Repeat	(рис.	1.9).

Рис. 1.9. Окно команды Step and Repeat

В	этом	окне	необходимо	указать,	во-первых,	сколько	копий	объекта	вы	хо-
тите	получить	(в	данном	случае	—	5).	Во-вторых,	указать	шаг	смещения	ко-
пий	по	горизонтали	и	вертикали.	Не	трудно	догадаться,	что	для	того,	чтобы	
вставить	5	горизонтальных,	идущих	подряд	копий,	необходимо	указать	шаг	
смещения	по	вертикали	равным	нулю.	А	для	того,	чтобы	выстроить	объекты	
в	столбец	—	по	 горизонтали.	 И	 еще	 одно	 условие,	 которое	 должно	 выпол-
няться:	 шаг	 смещения	 должен	 быть	 больше	 ширины	 или	 высоты	 объекта,	
в	противном	случае	копии	будут	накладываться	друг	на	друга.	Попробуйте	
получить	массив	объектов,	аналогичный	изображенному	на	рис.	1.10.
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Рис. 1.10. Пример использования команды Step and Repeat 
для получения массива объектов

Итак,	мы	рассмотрели	способы	копирования	объектов	для	получения	иден-
тичных	клонов	исходных	образцов.	Каждый	способ	подходит	для	своего	слу-
чая.	В	зависимости	от	целей	и	задач	выбирайте	более	подходящий	вариант.	
Главный	критерий	при	выборе	—	скорость	работы.

Навигация по документу
Навигация	по	документу	основывается	на	двух	действиях:	изменение	масштаба	
просмотра	и	перемещение	по	документу.	Для	изменения	масштаба	просмотра,	
а	его	можно	увеличивать	до	4000%	и	уменьшать	до	5%,	традиционно	использу-
ется	инструмент	Zoom	( ).	По	умолчанию	вы	работаете	с	инструментом	Zoom,	
на	котором	нарисован	(+),	что	означает,	что	он	работает,	увеличивая	масштаб.	
Каждый	клик	лупой	позволяет	вам	на	один	шаг	увеличить	масштаб	просмотра.	
Но	если	вам	нужно,	чтобы	инструмент	Zoom	работал,	уменьшая	масштаб	про-
смотра,	держите	при	работе	клавишу	<Alt>.	Численное	значение	текущего	мас-
штаба	 можно	 увидеть	 в	 нижнем	 левом	 углу	 документа.	 Но,	 честно	 говоря,	
инструментом	Zoom	для	описанных	целей	профессионалы	пользуются	редко.	
Гораздо	 популярнее	 горячие	 клавиши,	 увеличивающие	 и	уменьшающие	 мас-
штаб	просмотра.	Это	—	<Ctrl>+<+>	и	<Ctrl>+<>.	Для	быстрого	перехода	к	до-
кументу	размером	с	экран	необходимо	нажать	<Ctrl>+<0>.	Тогда	для	чего	же	
стоит	использовать	инструмент	Zoom?	Я	советую	вам	использовать	его	только	
для	того,	чтобы	получше	разглядеть	определенные	участки	документа.	Для	это-
го	нужно	инструментом	Zoom	провести	по	диагонали	там,	где	вы	что-то	хотите	
лучше	рассмотреть.
Теперь	давайте	поговорим	о	втором	важном	действии	—	перемещении	по	до-
кументу.	Это	становится	особенно	актуально,	если	вы	сильно	увеличили	мас-
штаб	просмотра.	Для	перемещения	по	документу,	конечно	же,	можно	пользо-
ваться	полосами	прокрутки,	но	это	не	совсем	удобный	способ.	Гораздо	удобнее	
пользоваться	 инструментом	 Hand	 ( ).	 Вы	 должны	 нажать	 левую	 кнопку	
мыши	и,	не	отпуская	ее,	двигать	курсор	в	виде	сжатой	ладони	по	документу.	
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Как	 вы	 догадываетесь,	 есть	 способ	 все	 сделать	 горячими	 клавишами.	 При	
любом	активном	инструменте,	нажимая	и	удерживая	клавишу	<Пробел>,	вы	
будете	временно	переключаться	к	инструменту	Hand.	Самые	хитрые	могут	до-
гадаться,	 что	 при	 работе	 с	 инструментом	 Type	 фокус	 с	 нажатием	 клавиши	
<Пробел>	не	пройдет,	т.	к.	в	тексте	будут	появляться	пробелы.	Поэтому	ис-
ключительно	для	инструмента	Type	существует	иная	горячая	клавиша,	вызы-
вающая	инструмент	Hand,	—	это	<Alt>.

Работа с направляющими линиями
По	умолчанию	в	рабочей	области	включен	показ	линеек	(если	они	отсутст-
вуют,	нажмите	<Ctrl>+<R>).	Линейки	используются	для	контроля	над	раз-
мерами	объектов	и	документа,	а	также	для	создания	направляющих линий.	
Направляющие	 линии	—	это	 элементы,	 не	 выводящиеся	 на	 печать	 и	 ис-
пользуемые	для	точного	позиционирования	объектов.	Для	того	чтобы	по-
местить	у	себя	в	документе	направляющую	линию,	вы	должны	нажать	кноп-
ку	мыши,	стоя	на	линейке,	и,	не	отпуская	кнопки	мыши,	потащить	курсор.
В	среде	InDesign	направляющие	линии	можно	двигать	и	выделять	как	обыч-
ные	объекты.	Для	этого	в	главном	меню	View	не должен	стоять	флажок	возле	
параметра	Lock	Guides	(Запереть	направляющие	линии).	Направляющие	все-
гда	 можно	 временно	 скрыть	 из	 видимости,	 поставив	 в	 главном	 меню	 View	
флажок	возле	пункта	Hide	Guides.
Давайте	рассмотрим	несколько	полезных	приемов	при	работе	с	направляю-
щими	линиями.
Быстрое	создание	направляющих	и	их	притягивание	к	делениям	линейки
1.	 Двойной	щелчок	по	линейке	—	создание	направляющей	в	месте	щелчка.
2.	 Удерживать	<Shift>	—	притягивание	направляющей	к	делениям	линейки	

(рис.	1.1).

Рис. 1.11. Пример направляющей, стоящей точно в делении линейки

Применение	команды	Step	and	Repeat
Команда	может	применяться	для	создания	множества	направляющих	линий.
1.	 Вытащить	первую	направляющую	линию.
2.	 При	выделенной	направляющей	выбрать	команду	Step	and	Repeat	и	ука-

зать	параметры	(рис.	1.12).
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Рис. 1.12. Команда Step and Repeat на фоне множества 
направляющих линий, полученных с ее помощью

Применение	нулевой	точки	для	создания	нескольких	направляющих
На	 стыке	 горизонтальной	 и	 вертикальной	 линеек	 имеется	 нулевая	 отметка	
в	виде	 перекрестия.	 Это	 точка	 отсчета	 ваших	 линеек,	 и	 она	 может	 быть	 ис-
пользована	для	получения	сразу	двух	пересекающихся	направляющих	линий.	
Если	 нажать	 <Ctrl>	 и	 после	 этого	 перетащить	 нулевую	 отметку	 линеек,	 то	
можно	получить	пересекающиеся	направляющие	линии	(рис.	1.13).	Нулевая	
отметка	при	этом	не	будет	смещена.

Рис. 1.13. Результат смещения нулевой отметки при нажатой клавише <Ctrl>

В	 InDesign	 существуют	 различные	 типы	 направляющих	 линий,	 и	 один	 из	
них	 это	 Baseline	 Grid	—	сетка	 базовых	 линий	 шрифта.	 Ее	 можно	 включить	
в	главном	меню	View>Show	Baseline	Grid	(рис.	1.14).	По	умолчанию	сетка	ба-
зовых	линий	шрифта	рассчитана	для	шрифта	размером	10	pt,	исходя	из	раз-
мера	 межстрочного	 расстояния	 12	 pt.	 Если	 вы	 хотите	 получить	 сетку	 для	
иного	кегля	и	интерлиньяжа	(межстрочного	расстояния),	то	необходимо	из-
менить	настройки	в	главном	меню	Edit>Preferences>Grids.	В	поле	Increment	
Every	введите	необходимое	значение.	Вас	не	должно	смущать	то,	что	в	этом	
поле	расчет	ведется	в	иных	единицах	измерения,	можете	вписать	туда	вели-
чины	в	каких	угодно	единицах,	только	припишите	их	сокращенное	обозна-
чение	(pt,	cm,	mm	и	т.	п.).
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Рис. 1.14. Раздел окна Preferences, посвященный сетке базовых линий

	 Для	 того	 чтобы	 сменить	 единицы	 измерения	 линейки,	 необходимо,	 щелкнув	
правой	кнопкой	мыши	по	линейке,	выбрать	нужные	единицы	измерения	либо	
глобально	 сменить	 измерительную	 систему	 документа	 в	 главном	 меню	 Edit>	
Preferences>Units	and	Increments.

Мы	рассмотрели	тему,	посвященную	работе	с	направляющими	линиями	и	ли-
нейками.	Теперь	вы	умеете	создавать	направляющие	линии	различными	спо-
собами	и	в	зависимости	от	ситуации	можете	пользоваться	тем	или	иным	прие-
мом.	 Использование	 направляющих	 линий	—	это	 хороший	 тон,	 поэтому	 не	
забывайте	о	них	во	время	работы	над	публикациями,	в	которых	необходимо	
точно	позиционировать	объекты.

Трансформация объектов
Во	время	работы	зачастую	необходимы	различные	действия,	меняющие	форму	
и	положение	объекта.	Для	этого	в	InDesign	существует	набор	инструментов	и	
команд.	 Первая	 из	 рассматриваемых	 нами	 команд	—	это	 команда	 Transform	
(рис.	1.15)	из	главного	меню	Object.	Она	же	доступна	при	правом	щелчке	мы-
шью	при	выделении	объекта.	Из	этой	команды	мы	получаем	доступ	к	четырем	
основным	действиям:	Move	—	переместить,	Scale	—	масштабировать,	Rotate	—	
повернуть,	Shear	—	наклонить.

 Рис. 1.15. Пример диалогового окна одной из команд группы Transform

Какой	бы	командой	вы	ни	воспользовались,	всегда	возможные	действия	будут	
одинаковы:
	указать	параметры	выполняемого	действия	(если	повернуть,	то	на	сколько	

градусов,	если	масштабировать,	то	на	сколько	процентов,	и	т.	д.);
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